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This Month’s General Meeting  
Tuesday, April 13, 2021 
will start at 6:00 P.M. @ 

FFG Christ Lutheran Church 
Note: Mask wearing & social dis-
tancing is mandatory during the 

meeting. 
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Summer Hours start at 6:00 P.M. (April through September) 
 
Winter Hours  star t at 3:00 P.M. (October  thr ough March) 
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade TN 

 

April 13th Presentation @  6:00 P.M. 

 
Purchase considerations for a 

printer in 2021 
 

This month's meeting, will have a video 
presentation by Ron Brown of the  
Slivercom CTC Group in Mesa, Arizona. 
  
Purchase considerations for a printer in 
2021 is a presentation he gave for APCUG 
at their Virtual Technology Conference on 
Feb 13 2021.  

Choosing a printer depends on how much 
you print but more important the frequency. 
What is the most economical printer for my 
use? There are many other printing options 
for color pictures or documents. What are 
ecotank printers and what is HP's new  
Neverstop laser printer that you fill-up the 
 laser cartridges yourself?  

Printing options for 2021 discussed. 

 

 

 

 
 
 

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of 
the SIG meetings as a guest will be charged $3.00 per per-
son for any or all meetings in that month. Afterwards, you 
are encouraged to become a member of the Plateau PC 
Users Group.  Our Club cannot exist without you, the 
members.  
  
Membership Dues  
Note: Due to the limitations of COVID-19, our annual 
dues have been reduced effective 8/12/2020.  Our annual 
dues are now payable July 1st. of each fiscal year.   
Reduced annual 2020 - 2021 dues are $15 per single per-
son / $20 per family.  Persons/families joining  
during the fiscal year have dues payable as follows: 
 

 
 

 
BOARD OF DIRECTORS DISCLAIMER 

All members of the Plateau PC Users Group are willing 
to help one another in the area of advice and tutorial in-
struction over the phone.  If you should require more in-
volved services or instruction, we have a few members 
who are very knowledgeable in several areas.  As a re-
sponsible  
consumer, it is up to you to discuss, before retaining a 
member, any and ALL charges for repair services and 
time consuming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees 
for individuals for services rendered, nor the responsibil-
ity to intervene between members who enter into a con-
tract among themselves. 
 
The GAZETTE is published using the following:  Mi-
crosoft Word, Microsoft Publisher, and Microsoft Win-
dows.  The Gazette is the monthly newsletter of the Plat-
eau PC Users Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is 
made by the PPCUG, the Gazette editorial staff or its 
contributing editors.  This extends to all losses incidental 
or consequential from the use or non-use of any infor-
mation in any issue of the Gazette. 
 
All images used in the newsletter, website, blogs, class 
materials or handouts (“media”)  are obtained from a “free 
use” source, preferably images that have been released as 
“CCO Public Domain”. 

 

2020-2021 PPCUG, Inc. Board Members 

 Join In 
July - 
Sept 

Oct - 
Dec 

Jan - 
Mar 

Apr - 
June 

Single $15 $15 $12 $6 

Family $20 $20 $15 $7 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Richard Del Frate (931) 456-2251 

Past President Carl Nordeen  (931) 456-5597 

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

   

Directors at Large 

Gordon Botting Richard Del Frate Barbara Duncan 

Charlie Merrick Bob Willis  

   

Printed by, Business Equipment Clinic 
539 West Ave. Suite 101  Crossville TN 38557 
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The next General Meeting of the 
PLATEAU PC USERS GROUP 

Tuesday, May 11, 2021 

Note: Summer Hours 6:00 P.M. 

** Visit the PPCUG Website ** 
At: www.PPCUGinc.com. 

 
Read all about our club activities and scheduled monthly meetings, also current and past issues of the  Gazette 
Newsletter. Links also to the Meeting Handouts on past presentations. 
 

Send your comments and suggestions to the PPCUG Webmaster, Alan Baker 
jackal33980@gmail.com  (931) 239-0877 

Cool Tips & Sites 

Quick 4-minute fix for Neck Hump 

If you spend a lot of time bent over a computer or device or are just worried about your posture, you're going 
to love this easy video. It offers 4 minutes of simple exercises designed to combat a forward posture slump 
and prevent that little hump on your back that's also known as a dowager's hump or buffalo hump. 

  

 
  

In this video, I was introduced to the YWTL exercise. This simple flow of arm positions is named after the 
shapes your arms make while doing the easy movements. I could immediately feel the difference in my back 
and neck when I ran through the sequence. 

https://youtu.be/T43753AfaKY  
 
Note: On opening, skip Add to view video 
 

https://cynmackley.us14.list-manage.com/track/click?u=b9d584f499b06d1f4e04af223&id=b59c13a49b&e=a7f77b4447
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How to Remove the Background From a Picture in Excel 

  MARSHALL GUNNELL  @MARSHALL_G08 
 

 

Removing a distracting background from an image allows your audience to focus on the subject matter. 
Though it is not known for its image-editing suite, you can do this using Microsoft Excel. Here is how it is 
done. 

First, open the Excel application and insert an image (Insert > Picture) that contains the background that 
you want to remove. 

 

Once it has been inserted, you will automatically be in the “Picture Format” tab. Here, click “Remove 
Background,” which is found in the “Adjust” group. 

 

Once it has been selected, the background of the image will appear magenta while the foreground remains 
untouched. The portion of the image that is highlighted in magenta is the area to be removed.  

Note: This can also be used the same way in Word. 
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Check System For Corrupted Files 

Here's a quick tip on how to check your system for corrupted files and other problems. 
  
Start by typing CMD in your search box. 
  

 
  

Right-click on the result and choose run as Administrator. 
  

 
  

The Command Prompt will open. 
  

 
  

You have two choices here. 

 If you want to verify and repair the OS type sfc /scannow (note the space between sfc and "/") 

(Continued on page 6) 
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 If you just want to check (verify only) the OS type sfc /verifyonly (no changes will be made using verify 
only) 
  
Make sure to type it in exactly as shown. 
  

 
  

The system scan will start. 
  

 
  

There are three possible results:  

 Windows did not find any integrity violations (a good thing) 

 Windows Resource Protection found corrupt files and repaired them (a good thing) 

 Windows Resource Protection found corrupt files but was unable to fix some of the errors. That's 
not a good thing. 

  
You may need to run the repair two or three times to take care of all the errors. 
 

(Continued from page 5) 
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How to Relieve Eye Strain In 20 Seconds 
 

Do your eyes get tired after spending a lot of time looking at a computer or phone screen?   
 
The Centers For Disease Control says it could be because you’re so involved with your Words With 
Friends Game, that you are forgetting to blink.   
 
The agency tasked with looking after the nation’s health says forgetting to blink causes fatigue.  So, don’t 
forget to blink! 
 

 
 
The CDC also suggests you follow what they call the 20-20-20 rule.  
 
About every 20 minutes, look away at something about 20 feet in front of you. Keep your eyes on that ob-
ject for 20 seconds. 
 
My eyes were actually getting a little tired while I wrote this, so I gave it a try. 
 
Looking away at something for 20 seconds, really did make them feel better.   
 
So, If your eyes are feeling strained, give it a try! 
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How to Use the Measurement Converter in Word, PowerPoint, and Outlook 

SANDY WRITTENHOUSE  @SANDYSTACHOWIAK 
 

 

Microsoft Word, PowerPoint, and Outlook offer a hidden measurement converter to save you from looking 
up conversions manually. If you’re working with a document, presentation, or email that contains measure-
ments, you’ll like this time-saving feature. 
 
Enable the Measurement Converter 
The steps to enable the Measurement Converter are the same for Microsoft Word and PowerPoint, with a 
slight difference for Outlook. So follow these steps for one or all. 
 
Enable Measurement Converter in Word and PowerPoint 
Open a document in Microsoft Word or a presentation in PowerPoint and click File > Options from the 
menu. 
Select “Proofing” on the left and click “AutoCorrect Options” on the right. 

 
 
Choose the “Actions” tab. Check the boxes for “Enable Additional Actions in the Right-Click Menu,” then 
“Measurement Converter” in the list. You’ll notice other actions you can enable, so mark any additional 
ones you’d like to use. 

 
(Continued on page 9) 
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Click “OK,” then “OK” once more to save and exit the options menu. 
 
Enable Measurement Converter in Outlook 
Open Microsoft Outlook and click File > Options from your inbox or an email window. 
Select “Mail” on the left and click “Editor Options” on the right. 
 

 
 
On the next screen, choose “Proofing” on the left and “AutoCorrect Options” on the right. 
 

 
 
Select the “Actions” tab. From here, check the boxes for “Enable Additional Actions in the Right-Click 
Menu,” then “Measurement Converter” in the list. Like with Word and PowerPoint, you can mark the boxes 
for any other actions you’d like to use. 
 

 
 

(Continued from page 8) 

(Continued on page 10) 
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Click “OK” on this screen and the subsequent screens to save and exit. 
Now that you’ve enabled the Measurement Converter, it’s time to put it to work. 
 
Use the Measurement Converter in Microsoft Office 
When you receive a document that includes measurements that you’re unfamiliar with, such as those from a 
foreign country, this tool takes the work out of manual conversions. And if you’re creating the document 
yourself, you can convert the measurement for your recipient or audience. 
Select the text containing the measurement. You can do this easily by dragging your cursor through it. 
 

 
 
Right-click and move your cursor down to “Additional Actions” in the menu. You’ll see the Measurement 
Converter in the pop-out box. 
 

 
 
This lets you view the conversion. So if you receive an email with a measurement in meters, for example, 
you can quickly see how much it equals in feet. 
Additionally, you can click to select a conversion from the list and it will replace the measurement in your 
document, presentation, or email. This is convenient when you are preparing an item for someone expecting 
a different unit of measurement. 
 
 

(Continued from page 9) 
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What’s the Difference Between Incognito Mode and a VPN? 

FERGUS O'SULLIVAN  @FERGUSOSULLIVAN 
 

 
 

VPNs and Incognito Mode are two of the most popular tools for online privacy. A VPN makes you harder 
to track while browsing, while Incognito Mode gives you a fresh browser that doesn’t remember your histo-
ry—and won’t give you away to websites while browsing on the VPN. 
 
What Is Incognito Mode? 

Private browsing has a lot of names, including InPrivate in Microsoft Edge and Incognito Mode in Google 
Chrome. Its purpose is to give your browser temporary amnesia. Whenever you’re in incognito mode, the 
browser will not store the data of the sites you visited: no addresses, no cookies, none of the data you en-
tered, nothing. 

Incognito Mode also gives you a fresh browser state without any cookies. So, if you’re logged in to Face-
book in your normal browser window, you can open an Incognito Mode window and Facebook won’t see 
you as logged in while you browse with that window. 

When you browse in Incognito Mode, nothing you do in your browser will be remembered by your browser 
itself. Web pages you visit won’t appear in your history or pop up in the “recently visited” tab. If you log in 
to a website, all you have to do is close the window and your browser will forget you ever signed in. 

However, this is all that private browsing can do, and your browser will usually tell you as much when you 
go into private mode. 

While none of your browsing data is stored on your computer, this doesn’t mean that it’s erased on the other 
end. Websites you visit can still see your IP address, your internet service provider can still see your activi-
ty, and system administrators at your workplace will still know what you were up to when you were sup-
posed to be working. Incognito and other private-browsing modes won’t make you anonymous online. 

 

(Continued on page 12) 
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RELATED: Does Private or Incognito Mode Make Web Browsing Anonymous? 

What Is a VPN? 

This is where VPNs come in. When you connect to a VPN, it will connect to the internet using a private 
server, making it appear as though that server is accessing a website rather than you. In other words, web-
sites you access won’t see your real IP address. They’ll see the VPN’s IP address. 

This improves your overall privacy while browsing, with the added bonus that you can spoof your location 
to anywhere in the world where your VPN has servers. Websites will see you as browsing from the VPN 
server’s region rather than your own physical location. This allows you to circumvent region re-
strictions on, for example, Netflix, or use online banking while on holiday. It’s also a great way to bypass 
online censorship and tracking in repressive countries. 

All that makes VPNs popular among a wide range of users, including regular people who like their priva-
cy, human rights activists who live under repressive regimes, and people who use BitTorrent to download 
the latest movies. 

RELATED: What Is a VPN, and Why Would I Need One? 

The Gaps in VPN Security 

A VPN works by routing you through an encrypted connection called a secure tunnel. Your ISP or a net-
work administrator can see that you’re connecting to an outside server—the VPN’s—but not what websites 
you’re connected to beyond that. This part of the process works like a charm, as tunnels generally use end-
to-end encryption. 

However, using a VPN does not guarantee complete anonymity. While your connection is cloaked, if you 
remain signed in to your social media or Google accounts, they can still track you. In other words: If you 
sign in to Google, connect to a VPN, and then keep using your normal browser where you’re signed in to 
Google—of course, Google still knows who you are. Browser cookies saved in your browser may also be 
used to track you. (Incognito Mode gives you a clean browser state, avoiding these problems.) 

Here’s the elephant in the room: The VPN service you’re using can see every single thing you’re doing 
while it’s active. 

In a way, you’re trading tracking by your ISP or your boss for tracking by your VPN. However, as part of 
their package, most VPNs promise to regularly delete their logs—the history of the connections any user 
has made. This is generally advertised as a “no-logs” policy, and on paper, it means that the VPN has no 
record of you or your doings. This means that it can’t share that information with your ISP, advertisers, 
law enforcement, or anybody else who might want to know what you’ve been up to. 

(Continued from page 11) 

(Continued on page 13) 
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In practice, though, not all VPNs are created equal in this regard. For example, in 2017, PureVPN was able 
to help the FBI catch a cyberstalker because, while it didn’t log user activity, it did log users’ IP addresses 
(It has since changed this policy.). VPNs are a bit of a black box, as are the companies behind them, which 
can make it hard to figure out which VPN to choose. Generally, we advise that people read through the pri-
vacy policy and check up on the service a bit before signing on. 

You’re placing a lot of trust in whatever VPN you choose, so do your research first. 

How to Use a VPN and Private Browsing Together 

While VPNs and Incognito Mode may not share any functionality, they do work extremely well together. 
Many of the gaps in VPN security can be filled using Incognito Mode, while Incognito’s shortcomings are 
covered by VPNs. Using them in tandem means that you’re making it harder for third parties to track you 
while also protecting your privacy from anybody you share your computer with. 

For example, in a private-browsing window, you won’t be signed in to your Google or Facebook accounts, 
and any cookies you’ve gathered while browsing are also deleted. 

At the same time, the websites you connect to can’t see your real IP address, and your internet service pro-
vider can’t see which websites you’re connecting to. 

This allows you to browse in relative anonymity—although you’re still trusting the VPN provider. 

While neither VPNs nor Incognito Mode can guarantee complete privacy, using them together brings you a 
lot closer to it than just using one. 

Staying Safe on the inter-net 
 

Phishing is the fraudulent practice of sending emails that appear  to be fr om a r eputable company 
with the goal of getting you to share sensitive information. Often, the targeted information includes login 
credentials, credit card information, bank account details, or other personal information.  
 
You may be less familiar with spear-phishing, which is a highly targeted for m of phishing. Unlike a 
general phishing attack, that casts a very wide net (sending generic, mass emails); a spear-phishing attack is 
personalized with specific details about the message's recipient.  
 
Spear-phishing attackers may gather  per sonal infor mation from your  social media accounts or  the 
dark web to create messages that appear to come from trusted sources—like companies or even individuals 
that you know. They use these personal details to trick you into taking an action that could cause you to 
share even more personal information. Most frequently, the attacker suggests clicking a link or download-
ing software that contains malware or spyware, which could compromise your personal and account infor-
mation, potentially including financial and banking accounts.  
 

(Continued from page 12) 
 

(Continued on page 14) 
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Ways to stay safe 

 Do not click on links or attachments in emails or text messages from senders that you do not recog-

nize. If you hover over a link in an email, you will be able to see the location where the link will 

take you. Often, a link is suspect if it is long, confusing, contains typos, or mentions domains you 

do not recognize.  

 Be especially wary of attachments like .zip or .pdf and particularly of executable file types (like 

those that end in .EXE). If you do not know the sender personally, you should never download or 

click these attachments. 

 Do not provide sensitive personal information (like usernames and passwords) over email. 

 Do not fall for messages that claim to be "urgent" or "time-sensitive". Often, scammers will try to 

scare you into sharing your personal information. Always take time to verify the identity of the re-

quester and remember that Quicken and other reputable businesses will not ask you to provide sen-

sitive information over email or over the phone. 

 Pay attention to even seemingly harmless requests. A common ploy scammer’s use is emailing you 

a link to do something like change your account password. The link, in reality, will download mal-

ware or spyware. 

 Do not open any document that you are not expecting to receive. 

 If you can't tell if an email or text is legitimate, err on the side of caution and delete it. You can al-

ways call the business directly with any questions or concerns. 

 
 

(Continued from page 13) 
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Plateau PC Users Group, Inc.  
 

 Revised Application for Membership 
   
            ------- New Member    ------ Renewing Member 
 
Return this application with check foe annual dues payable to “PLATEAU PC USERS GROUP” Return to 
the club Treasurer during our meeting or mail to “PPCUG Treasurer. P.O. Box 3787, Crossville TN  38557” 
 
Note: Due to the limitations of COVID-19, our annual dues have been reduced effective 8/12/2020.  Our 
annual dues are now payable July 1st. of each fiscal year.   
Reduced annual 2020 - 2021 dues are $15 per single person / $20 per family.  Persons/families joining  
during the fiscal year have dues payable as follows: 
 

 
 
Date: --------------------               Amount Paid: $ --------------------   by Cash ------ , or Check (# ----------------------- ) 
 
--------------------------          -------------------------      -------------------------------------------- 
Last Name   First Name  Family Member (if family membership) 
 
------------------------------------------------------------------------------- 
Address: 
 
--------------------------------------        --------           ---------------    (-------------) ----------------------------- 
City     State  Zip Code Phone Number 
 
E-Mail address: ---------------------------------------------------------------------- 
    Please Print 
 
I have belonged to a Computer Club before:  Yes -----------     No ------------  
 
I have used PC’s since (year): ------------------  
 
I have knowledge in the following areas that I would be willing to share with club members: 
 

 
 

 
 

 
 
September 2020 

 Join In July - Sept Oct - Dec Jan - Mar Apr - June 

Single $15 $15 $12 $6 

Family $20 $20 $15 $7 
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May 2021 

Sun Mon Tue Wed Thu Fri Sat 

      1 

2 3 4 5 2:00 P.M. 

PPCUG 
Board Mtg. 

6 7 8 

9 10 11 6:00 P.M. 
General Mtg. 
Presentation.  
Followed by 
Q&A Session 

12 13 14 15 

16 17 18 19 20 21 22 

23 24 25 26 27 28 29 

30 31      


